PH354, NCSSM, 8/19/05

Lab C2.  Investigating Simple Harmonic Motion 

Goals:  1) to gain an understanding of Hooke’s law for springs;  2) To investigate position, velocity, and acceleration of an oscillating spring as a function of time; and 3) to compare the maximum values of these quantities to those calculated using the amplitude of the motion, spring constant, and mass on the spring.

Reading: Walker Section 6.2, 7.3, 8.5, 13.1 – 13.5 

Before you start: If you are taking calculus (or have already had it), you might want to choose a lab partner who also knows calculus. Check with your teacher for advice on this issue.
Items shown in brackets in the instructions must be included word-for-word on your paper. 

Prelab.

A light mass, mL, is hung from a vertical spring of spring constant, k.  When the mass is stationary, the spring is stretched an amount, xL, from its unstretched position.

1.	Create the appropriate force diagram and do the net force problem to find an expression relating xL to mL, g, and k. This also requires 2 pictures, one showing the unstretched spring, one showing the stretched one.  See the sequence of pictures below.
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2) Now suppose a heavier mass, mH , hangs from the same spring; it stretches (relative to unstretched) the spring by an amount xH.  Repeat your procedure above to write an equation relating  xH, mH, g, and k 
3) In lab, the sonic ranger (or Motion Detector) will be placed on the floor, below the mass hanging from the spring.  The sonic ranger will be able to measure the heights (hL and hH) of the masses when they are hanging in equilibrium from the spring.  Label the floor and the heights hL and hH when you transfer this diagram to your lab book.
4) Use your equations (from #1 and #2 above) to solve for the value of the spring constant k in terms of only of known or measured quantities:  g, , mH , mL , hL, and hH .   
Note that you will have to relate the quantities xL and xH to hL and hH .  Pay attention to signs (which is larger: xL or xH ? which is larger: hL or hH ? )

Equipment and Experiment Setup:
1. Plug motion detector into 	DIG/SONIC 2, 	NOT  		DIG/SONIC 1.
2. Plug force sensor into Port 1 and make sure the switch on the sensor, if there is one, is on 10 Newtons.
3. In the Logger Pro software, select the File menu, Open, and choose the Experiments directory, then Probes & Sensors, Motion Detector, MOT&DFS.  Press Open.
4. Note:  No calibration of the motion detector should be necessary at this time—it should automatically give accurate values.  Contact your instructor if for some reason you feel the detector needs to be recalibrated.
5.  Minimize the graphs window and maximize the Data Table window.
6. Go to the Experiment Menu, Data Collection, Collection tab, and change the sampling speed to 30 samples/sec.  Set the experiment length to 5 seconds.

Part I.  Measuring spring constant and period
Be sure to use the same spring throughout this entire experiment.  
If you change your spring in any way,  the spring constant will change and you will have to start over..
1. Write the identifying letter of the spring you are using.        
[Spring color and letter =]
2. Gently hang the 0.050kg weight hanger and an additional 0.200kg from the spring. Tape a piece of cardstock to the bottom of the weight hanger to increase the reflection area. Position the sonic ranger on the floor directly below the weight hanger. With the motion sensor below the weight hanger, press Collect. The position should read constant.  Record this value. Position the rod that supports the spring so that the bottom of the weight hanger is 0.60 to 0.80 m above the ranger.  Be sure that the ranger is not reading the bottom edge of the table.  When the weight hanger is motionless, record the position reading.
	[Equilibrium position for 0.250 kg =]
3. Now add 0.200 kg to the weight hanger (for a total of 0.450 kg) and read the position again.
	[Equilibrium position for 0.450 kg =]
4. Use your prelab result to calculate the spring constant value.  The spring constant should have units of N/m.  Check to make sure that it does
	[Calculated spring constant =]
5. Using the spring constant, calculate the position that the spring would have (as measured by the Motion Detector) if 0.300 kg were added to the weight hanger (i.e., a total mass of 0.350 kg now hangs from the spring).  Then measure the position with the sonic ranger.  Remove the sonic ranger once you’ve made the measurement.
	[Calculated position of 0.350 kg =]
	[Measured position =]
	[Percent difference =]
6.  Leave a total of 0.350 kg hanging from the spring.  Set the spring into oscillation by lifting it up--but not so much as to completely relax the spring--and releasing it; i.e., the amplitude of the simple harmonic motion that results should be small.   Measure the period of oscillation to 3 significant figures using a stopwatch.  Describe the method that you used to get 3 significant figures.
	[Number of cycles =]
	[Total time measured =
	[Measured period of 0.350 kg =]
	[Description of how 3 significant figures were obtained]

7.  Assuming that the period, P, of an oscillating spring depends only  the spring constant, k, and the mass, m, determine the mathematical combination of k and m that gives the right units for period—hint:  what is the definition of period?  This result should be correct to within a constant numerical factor, to be determined in step #8 by experiment.

8. Using the spring constant, mass, measured period, and the result of #7, calculate the numerical constant in the formula for period.  What does the text say this constant should be? Percent error?
	[Calculated constant =]
	[Expected constant =]
[percent error =]

Part II.  Equation of position vs. time
1.	A total of 0.450 kg should be placed on the spring. Use masking tape to hold the weights securely to the weight hanger. This is done SO THAT THE WEIGHTS WILL NOT FALL ONTO THE SONIC RANGER or your foot.  
Measure the position of the bottom of the weight hanger as you have done previously.
[Equilibrium position for 0.450 kg mass = ]
2.	If you have not already done so, go to Experiment Menu, Data Collection, Collection tab, and change the sampling speed to 30 samples/sec.  Set experiment length to 5 seconds.
3.	If you do not already have a position vs. time graph ready for you, go to Insert Menu, Graph, and click on the label of the y-axis of the graph that appears.  Select Distance Only.  Click OK.  
4.	You should have a position vs. time graph now.  Click on the y-axis itself, go to axes options, and press manual scaling.  Enter 0.4 m as the bottom, or min. value, and 0.8m as the top, or max.  
5.	Set the spring into oscillation.  Click Collect to start data collection.  You should obtain a smooth, sinusoidal graph.  If your graph is not within the 0.4m<y<0.8m range, adjust the vertical position of your spring on the ring stand.  There may be stray points toward the end of the time interval if the spring starts to sway from side to side.  Make a half-page sketch of the graph, labeling the axes and placing numbers on them.  Draw a horizontal dotted line to show the equilibrium position of the spring.
	a)  Now remove 0.100 kg mass from the weight hanger so that a total of 0.350 kg hangs from the spring.  Measure the equilibrium position as you did in Part I, #2.

	[Total Mass = 0.350 kg]
	[Measured equilibrium position =]
b) Set the spring into oscillation.  Obtain another graph and make a half-page sketch.  Describe several ways in which this graph is different from the one sketched in step 4. Save your data file to your personal drive in case there is a computer glitch.
	In the Analyze menu, select examine.  x,t coordinates for each of three consecutive extremum points will be displayed when you place your cursor at these points.  (An extremum point is a peak or a valley on the graph.) These points span one complete cycle of the motion.  Record the results with units.

	[(t,y) coordinates of consecutive extremum points =]
	Use the data to calculate the period of the motion.  Show your work.  As a check, this value should be within 5% (percent difference) of the value calculated in Part I number 6.

	[Period calculated from graph =]
	[Measured period from Part I =]
	[Percent difference =]
	Use the data you collected in step 8 above to calculate the equilibrium position.  Show your work.  Compare to the measured value.

	[Total mass =]
	[Calculated equilibrium position =]
	[Measured equilibrium position =]
	[Percent  difference =]

	Use the step 8 data to calculate the amplitude of the motion.  Show your work.

	[Calculated amplitude =]

	The goal of this part is to determine the equation for the position, y, of the spring as a function of time, t.  (Having the appropriate section of your text available might be helpful.) First decide whether you want to call the curve a sine curve or a cosine curve.  (Why is the choice arbitrary?)  Then decide how the constants of the motion calculated in 8, 9, and 10 will be incorporated into the equation.  Finally, determine a phase shift (an angle or time) that must be added to the argument of the sine (or cosine) function in order to bring your equation into correspondence with the actual experimental curve.  Also describe how you determined the phase shift.  Give the equation of fit in symbols only first, and then substitute constants with units.   Use the manual curve fit from the curve fit option under the analyze menu to visually check how well your equation fits the data.  Make corrections to your fit if needed.


	Now check your equation by substituting the time coordinate for one of the data points to see if you get the correct position.  If you are doing the lab with a partner, each of you should select a different time coordinate.  Show your work.

	[actual (t,y) coordinates of selected point =]
	[Calculated position =]
	[Percent difference =]

	Physically, what does the phase shift represent about the initial conditions of the experiment?



Part III.  Position, velocity, acceleration, and force relationships
In this part of the lab, you’ll measure the displacement, velocity, and acceleration of the spring with the sonic ranger at the same time that you measure force with the force probe.  
1) Record the letter of your computer.  Open the software in the same way as Parts I and II:
  In the Logger Pro software, select the File menu, Open, and choose the Experiments directory, then Probes & Sensors, Motion Detector, MOT&DFS.  Press OPEN.
[Computer:  ]
2) 	Go to Experiment, Data Collection, Collection tab, and set the experiment length to 2 seconds and the sampling speed to 30 samples/sec.  Press DONE.
3) 	Calibration:  You first need to calibrate the probe to measure force in newtons. To do so, use the following procedure:
·	Remove all weights, except the spring.

·	Go to Experiment Menu, Calibrate, and select the CH1 device (Dual Range Force).

·	If the software presents an error reading, "The default calibrations folder could not be found,” or "The folder does not contain the correct calibrations,” then press OK to these errors. Click Cancel on the calibrations screen, and select File  Preferences. On the "Default Folder" field, press the Browse/Modify button next it. Select the C:\Program Files\Vernier Software\Logger Pro 2.0\Experiments\ folder. Press OK. This will remedy the error message. Select Experiment  Calibrate again.

·	Press Calibrate Now;

·	The probe sends an electric signal in the form of a voltage to the interface/computer.  This voltage will be displayed now.  Wait for the voltage reading by "Channel 1" to stabilize, and type "0" (zero) into the Value 1 box,  and press Keep.  You just informed the interface/computer that this voltage corresponds to a reading of 0 Newtons on the force probe.
 
·	Now hang a known mass 0.350 kg total, on the spring;
 
·	When the voltage reading stabilizes again, enter the corresponding force in Newtons to 3 significant figures in the Value 2 box and press Keep (you have to figure out this force value).  You just informed the interface/computer that this voltage corresponds to a reading of ______ Newtons on the force probe. How do you know what the force should be?
 [ Force =         ]
Now the probe/interface/computer combination has all of the information needed to convert voltages to the correct corresponding force values.	
4) The software probably opened with a block of 3 graphs ---distance, acceleration, and force-vs-time.  You will need to close these.  Do not close the data table; do not minimize the data table.
Go to Page menu, add page to get a new page workspace, and then go to the Insert menu, Graph, and select it.  On one page, you need to configure two graphs (Insert, graph) which are pos. v time and vel v. time.  On another page, you will need to configure two more graphs, acceleration v. time and force v. time.  Each of the graphs should have the same time range (2.0 sec should be fine).  If you want to print two of the graphs, minimize one of the two-graph windows, and make the remaining two-graph window fit the screen

5) Place 0.300 kg total mass on the spring.  Set the mass into oscillation and collect data.
[Total Mass = ]

6)  You should get a smooth curve for the position and force graphs, but the velocity and acceleration graphs may show some scatter in the points.  (This has to do with the method used to calculate velocity and acceleration from the position data.) Select View, then Autoscale if the curves are not showing on any of the graphs. Then collect data as before.

7)  To obtain a curve fit to any of the graphs, select Analyze, then Automatic Curve Fit, then Sine.  Do curve fits to at least the position- and force-vs-time graphs.
Write out your fit equation with correct symbols and coefficients rounded to proper significant figures and with SI units.
[x-t fit: ]
	
[F-t fit: ]

8)  a) Print out your final graphs.  Make sure your fit results show on the printouts.  In order to conserve paper, print two graphs per page:  the position and velocity graphs on one page; the force and acceleration graphs on the next.  Be sure to print them all with the same time scale.  Printed data tables are not necessary.
b) Save your data/graphs to your m drive now for future reference.

9) a) Use the position vs. time fit to obtain the following information. 
[amplitude = A]	
[angular frequency = w]

b) Use the force vs. time fit to obtain the following information:
		
                     [angular frequency = w]
c) Should the angular frequency of the position and force graphs be identical?

		[percent difference =]

10) Use your graphs and/or fit results (not physics theory or calculus) to answer the following questions:
A) Where (in position) is the mass when the velocity is a maximum?  What is this velocity? What is the acceleration at this point? Where, relative to its equilibrium position, is the mass at this point (at equilibrium, above equilibrium, below equilibrium ?) [To find curve or slope values, select Analyze, then Examine or Tangent Line.]

[position of mass at maximum velocity =]
[maximum velocity =]
[acceleration at maximum velocity =]
[position of mass relative to equilibrium (above, below, at) =]

B) Where is the mass when the acceleration is a maximum?  What is the value of the maximum acceleration?  What is the velocity at this point? Where, relative to its equilibrium position, is the mass at this point (at equilibrium, above equilibrium, below equilibrium ?)
[position of mass at maximum acceleration =]
[maximum acceleration =]
[velocity at maximum acceleration =]
[position of mass relative to equilibrium (above, below, at) =]

C) Does the maximum acceleration magnitude occur at the same time as the maximum force magnitude?  What physics predicts that it should? (remember what force is being graphed !)
[maximum force from force graph =]
[minimum force from force graph =]

D) Does the maximum displacement magnitude occur at the same time as the maximum acceleration magnitude? What physics predicts that it should?

One way to summarize some of the results above is to say that the position and velocity are 90° (1/4 cycle) out of phase, and position and acceleration are 180° (1/2 cycle) out of phase.  Net force and acceleration, though are 0° out of phase - that is, they are in phase. 



Part IV: Interpretations
Answer the following questions to help in checking and interpreting your results from Part III.
1.	Use your amplitude and angular frequency determined in Part III, plus basic physics laws, to predict i) the maximum velocity, and ii) the maximum acceleration of your mass. If you know calculus, you may make your predictions instead by taking appropriate derivatives of the position vs. time equation. If you already did Follow-up Problem 3 (below), you do not need to rederive the formula for maximum velocity (you can just quote your result from that problem). Then find the percentage differences between the predicted values and those obtained directly from the corresponding velocity and acceleration fits from Part III. 
2.	In Follow-up Problem 2 (below), you will prove that the maximum spring force is equal to kA+mg. Calculate the maximum force using the expression kA+mg and your measured spring constant, amplitude and mass. Find the percentage difference between this value and the value from the force fit. 

Conclusions



Part V: Follow-up Problems concerning a mass on a spring oscillating vertically.

1	Let's define the quantity xeq to be the amount the spring is stretched (from its natural length) when the hanging mass is at equilibrium. Also, let's define the positive direction to be down for all variables (this means, for example, that xeq will be a positive number).  In other words, x will be negative only if the spring is compressed from its unstretched (natural) length. 

a.	Draw FOUR large side-by-side “snapshots”, that show the spring and mass for four cases: unstretched (no mass), with hanging mass at equilibrium, with hanging mass at its lowest position, with hanging mass at its highest position. Draw a horizontal line across your diagrams to show the place where x=0.  Draw and appropriately label additional horizontal lines which indicate the amount x that the spring has been stretched (for the equilibrium position, this will be xeq.  Finally, label the positive direction (down).    
b.	Now draw THREE force diagrams side-by-side (each extreme position and equilibrium position) and write ONE net force equation for the oscillating mass; the equation should apply to any of your three situations in which the mass appears! Even though the acceleration of the system is in different directions for each of the situations, for consistency in this problem you must choose the same positive direction for each situation. This means that the acceleration will be a negative number for one of the situations (which one ?)
c.	Using the force equation you determined in part b, determine an expression for acceleration that is in terms of k, m, x and xeq values only.  (Hint:  one of your force diagrams from above should help you get rid of the “g” in the force equation.) You should recognize this result as being the same as that for a horizontal spring: the acceleration of the system (and thus the net force on the system) is proportional to (and opposite to) the displacement of the system from equilibrium. As discussed in Walker, section 13.5, under that condition the system will exhibit simple harmonic motion. You have therefore demonstrated the reason that a mass on a vertical spring moves in simple harmonic motion, even though gravity is now seriously involved!
  
2.  Prove (as was assumed in Part IV, problem 2 of the lab) that the maximum spring force acting on the mass is kA + mg. Diagrams are necessary (to save writing, though, you may refer to relevant diagrams that you did in follow-up problem 1).  Also determine the expression for the minimum spring force in this vertical oscillation situation (it isn’t zero!).
3.  By now you have (in class) done the energy analysis for a simple friction-free horizontal mass-on-spring oscillation.  Here your goal is to do the energy analysis for the vertical case to prove that the speed of the mass as it passes through the equilibrium position is v = A(k/m)½.  You'll have to include three kinds of energy in your solution, and you'll also have to especially use one of your force diagram results from number 1. Again, diagrams necessary ! (you may again refer to any that you've already drawn, to save writing).  You should recognize this as being the same result as for a horizontal spring.

SO WHAT DOES THIS ALL MEAN?????????  It means when you have a simple vertical mass-on-spring oscillator you can use the exact same equation of motion (position vs time equation) and maximum speed equations as you used for the horizontal case, even though gravity is there trying to make things complicated!

